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MATHEMATICAL MODEL OF REHEATING FURNACE/THERMALSYSTEM/

SYSTEM IDENTIFICATION AND GENETIC ALGORITHM.

Temperature control in heating curve up process for reheating furnace walking
hearth type in Ratchasima Steel Products Co.,Ltd. (Nakorn Ratchasima, Thailand),
which using about 50 - 60 hours. The heating process affect to rate of fuel
consumption and steel rod process. In heating curve up process can’t heat suddenly,
which cause the furnace damaged. Therefore, it is important to control the temperature
in soaking zone respect to reference temperature by on - off burner’s technician. This
research present mathematical model estimation method by heat balance equation
dominates convection heat transfer. The result compare with experiment data in each
zone. On - off Burner method design by genetic algorithm base on of open - loop
identification method. The result of design relative to reference temperature and

economize fuel in heating curve up process.
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22 18 AR 1 auMIN (3.8)

dr,
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q; =

|
Ry

a3

-9y T G

(7,-7,)

(3.8)

(3.9)
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Taemn C, #eo mnnuyauioui Heating Zone (J /°C)
R, Ao AWWA TumuAIE oUsE1IN Heating Zone a2 Soaking Zone (°C /W)
A v J 9 A .
44> A0 DATININUNANUIDUNTUNIUHeating Zone (W)
g, AP BATINININANNS OUTZYI 1 Heating Zone LAY Soaking Zone (W)
T, Ao Qm‘ﬂﬂvﬁﬁ Soaking Zone (°C)

9 . ya = 1 9
° mﬂizuummmuiu Soaking Zone vlﬂ‘WinimWﬂﬂﬂ'liﬂWElWlﬂ’JHJi'E]u
U Qd‘ 1 [ [ d‘ a L 1 9 d'
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/}//é//////
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19 3.7 naasszuumsmemanuoui Soaking Zone

2218 Haad 9 aunIN (3.10)

dT,

C_3=qurner-q +qis 3.10
3 b 3 " Daisi3 (3.10)

Y dy a [ ~
HazaumMImMIE 11 vous oImaLaadn 1 aun1sh (3.11)

Gpmer = NVLHV (.11)
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Taemn C, feo mnuganuioun Soaking Zone (J /°C)

G4z A9 ©asIMIDI0NANNEoUNTUNIUSoaking Zone (W)

A 1% U 9 Aa 9
9 puner N0 gasImsmomanuieunnavninnswn bl ()
N fe swudwnndaie N=1,2.3,...,10

9
1% Ao BnsIMIMasasveusenas (L/ Hr)
Y '

LHV do sanudoudomasiid /L)

NAUMIN (3.6) az (3.7) unuam luaunmsn 3.5) 1218 taasdeaunsn (3.12)

1
C,E—R—Z(Q-T])—;](T]—To)wm (3.12)

(Tz_]-;)+qdist2 (3.13)

&
=u|H

2

dT, 1

C,—2=NLHV -—(T,-T, ) +q,, (3.14)
3dt R3(3 2) dist3

1% 03} Y

aai wazlan
af, . U . 1 1 (3.15)
_ = = - - qiS . 5
d ' CR,* CR, ' CR ' CR " ™
ar, . 1 1 1 1
—2=7 = T, - T, - T, + T, +q 0 (3.16)
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aT; T, : : T, + NvLHV + (3.17)
—=L=—10-— v 9ais 17
d > CR ' CR,° a3

3.3 uuudiaeenmilsaman (State Variable Models)
o (3 = @ I v o v W 24 &4 dy t4
uuud a0 wlsanalgld nyaziluaumseyWus e yo ua unil g uv o1lsz Tewu

[ o 9 a o o [ @ @ = =\ [ d'
ABMIA TUIUA IADUNANDTE MTUA W5 x(1) uuUd 1ls@edn i uanR seumsn (3.18)

ix(t) = ax(t)+bu(t) (3.18)
dt

Tunsalvaned alsenINsouanIaunsaan (State Equation) 18 LaAIA@un13h (3.19)

d
—x=Ax+Bu (3.19)
dt
Taeh X fe  @wlsmeeueeszuy
U AD DUNAVDITIUY
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@ 4 . @ = = [ =i
FIUN ATUNITLOIA WA(Output Equation) LUUUA mﬂimmngﬂgmu UAANAITUNITN (3.20)
V(1) = cx(t)+ du(t) (3.20)
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y=Cx+Du (3.21)
o @ = 4 9 a 4 =
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] 9 [ ~ 4 [ ~
aq“lugﬂmmanmimm"lﬂ LAANATUNITN (3.22) LASTUNITOIANA LAANAITUNITN (3.23)
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1

d' (2 ] 3 Y [ d'
NAUNITN (3.22) FWTDUNUA 11)5981991818 Laad aunsn (3.24)
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d e
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A 1
e f9
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4 0 Gy " G
TZ + O N+ qdistZ
Iy ] |[VLHV Qaises
(3.23)
aly + 44
9 gisi2 (3.24)
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o o a
M3199 3.1 uaaand ks Tasdszananimguyg
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R, 0.00398 - 0.00596 (°C /W)
R, 0.00238 - 0.00358 (°C /W)

R, 0.00331 - 0.00497 (°C /W)

C 93,058.33 - 147,964.10 (J /°C)
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C, 11,167.00 - 34,717.06 (J /°C)
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ST A szunaa uls

oanesiu GAl GA2 GA3 GA4 GA5 GAG6 GA7 GAS GA9 GA10
‘]Ji%‘]ﬂﬂi 20 50 100 200 300 50 50 50 50 50
30U 10,000 10,000 10,000 10,000 10,000 15,000 20,000 30,000 40,000 50,000
ax 10—2 0.39899 0.39899 0.41999 0.40998 0.39900 0.39863 0.41995 0.40001 0.43998 0.39899
bx10—2 0.29999 0.30658 0.32419 0.28999 0.30003 0.28765 0.29994 0.29989 0.33584 0.30021
Cx 10—2 0.59999 0.59972 0.60998 0.57345 0.59999 0.55232 0.58921 0.60863 0.61998 0.59998
dx10—2 1.29999 1.29997 1.29999 1.24998 1.29999 1.22086 1.26541 1.22961 1.31567 1.29955
ex 10—2 1.39997 1.41997 1.44988 1.39995 1.39999 1.35542 1.44995 1.42531 1.41997 1.39856
fx 1073 0.32981 0.33187 0.33818 0.33496 0.32981 0.32575 0.33778 0.33609 0.33192 0. 32974
G istt 0.66999 0.66999 0.69999 0.61999 0.66995 0.50947 0.69999 0.66969 0.68997 0.66842
9 jista 0.51997 0.51999 0.59998 0.47889 0.51995 0.39301 0.59997 0.51999 0.54948 0.54985
G st -0.90011 -0.90051 -0.90001 -0.95001 -0.90001 -0.98665 -0.80003 -0.92013 -0.96050 -0.90014
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UUAN . MANUAINANDDY (%)
- nanms
2aNdINY GA1 GA2 GA3 GA4 GAs GA6 GA7 GA3 GA9 GA10
Useans 20 50 100 200 300 50 50 50 50 50
Tasus
79U 10,000 10,000 10,000 10,000 10,000 15,000 20,000 30,000 40,000 50,000
Sum Square 14.946 14.862 14.416 15.143 14.946 15.533 14.706 14.844 14.217 14.942
Preheating Zone
Mean 5.7017 5.2262 4.7542 6.8815 5.7017 6.8143 6.2734 5.7685 4.6744 5.6986
Sum Square 12.829 12.825 12.898 12.871 12.830 13.136 12.632 12.774 12.715 12.825
Heating Zone
Mean 6.7410 6.7117 6.7281 6.8655 6.7411 7.0041 6.5480 6.7691 6.7457 6.7351
Sum Square 17.714 17.705 17.898 17.938 17.714 17.582 17.959 17.965 17.710 17.713
Soaking Zone
Mean 6.7995 6.7207 6.8049 7.0963 6.7994 6.8471 6.9504 6.9954 6.6829 6.7982
2 ' ) ' v v =
AITNN 5.3 UFAINIAITNIANUIDULAZAINIINATUMUAITNIDUUDINANTITNAADIN 1
aunls GAl GA2 GA3 GA4 GAS GA6 GA7 GA3 GA9 GA10

Rl (OC / W) 0.00597 0.00569 0.00539 0.00531 0.004793 0.004579 0.00438 0.00462 0.00427 0.00397
R2 (OC/W) 0.00385 0.00342 0.00324 0.00319 0.00288 0.00275 0.00263 0.00277 0.00256 0.00239
R3 (OC/W) 0.00498 0.00479 0.00449 0.00443 0.00399 0.00382 0.00366 0.00385 0.00361 0.00331
Cl (J/OC) 93,058.33 95,407.03 95,235.68 108,146.6 115,916.7 135,586.8 126,750.0 120,250.0 116,123.9 139,732.1
C2 (J/OC) 46,529.17 48,750.00 50,614.75 54,690.48 57,958.33 70,497.91 64,535.2 59,304.53 62,903.23 69,866.06
C3 (J/OC) 14,357.57 14,830.99 15,331.03 16,126.29 17,884.29 20,712.18 18,881.38 18,291.55 19,774.65 21,558.67
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600
L
1]
[
]
1
1
:
500 1
!
i
—~ 400 o
&) ',/
8 /
Bh 2
() 3 v
8 raadi
q) Cd
§ 300
<
;Q,‘ """ Experiment
[}
S ——GAI
200 e
ﬂ,ﬂfﬁ‘w‘ i N [, GA2
"
V»”"p ----------- GA3
100 o o i
?,;»;::’P”/ GA4
I GAS
0 i i
0 500 1000 1500 2000 2500 3000 3500
Time (min)

JUMN 5.12 HAAINANTADVTUDIVOIRUHYNIINHANIITNATDIN 2 t1azMIUTeUIUVT 10D

TagduILANS AN NMIVUA 11 UAT 1WIUTOUAN 11 Preheating Zone



63

Heating Zone (T2)
1200 g
""" Experiment ;
1000 | —— GAl ;
]
------- GA2 ,
"""""" A
~ 800 GA3 j
O H
g | | GA4
& 3
()
a GA5 o
g 600 f/.»" ",,
S L ——— s
2 o
s
400 ""v;
)
‘::’::;‘—,-' B st e
~——- .
200 ),?J'::/ )/
o
0
0 500 1000 1500 2000 2500 3000 3500
Time (min)

JUMN 5.13 HAAINANTADVTUDIVOIUHNIINHANITNATDIN 2 tazMIUTeUUUVT 10D

TagdumAnse anes NwuUA 11UAT 1WIUTOUAN 11 Heating Zone



64

Soaking Zone (T3)
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Preheating Zone (T1)
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A15190 5.4 uaasmszanua ’J!Lﬂiﬂl@ﬂiﬂiﬁﬁ%ﬁlmﬂi} TN NAUAMTAT AR UUAND ﬂﬂ@iﬁlﬂl@\maﬂﬁ%ﬂa@\iﬁ 2

ST A szunaa uls

oanesiu GAl GA2 GA3 GA4 GA5 GAG6 GA7 GAS GA9 GA10
‘]Ji%‘]ﬂﬂi 20 50 100 200 300 50 50 50 50 50

30U 10,000 10,000 10,000 10,000 10,000 15,000 20,000 30,000 40,000 50,000
ax10—2 0.49789 0.49998 0.49989 0.54982 0.59998 0.54996 0.59988 0.59992 0.49997 0.03981
bxlO_z 0.22848 0.22848 0.22679 0.24265 0.25945 0.24174 0.25698 0.25658 0.23030 0.04128
c><10_2 0.55513 0.55513 0.57761 0.63876 0.63698 0.65916 0.68134 0.68342 0.57347 0.98020
dx10—2 1.49847 1.49995 1.59987 1.78882 1.78899 1.88991 1.98992 1.99932 1.49993 5.01494
ex10—2 1.79996 1.79995 1.89998 1.89998 1.88889 1.95996 2.00992 1.99402 1.63999 3.24169
fx 1073 0.39884 0.39885 0.40790 0.39770 0.39674 0.40159 0.40302 0.39994 0.37688 0.30004
G istt 0.89999 0.89977 0.94999 0.89999 0.89965 0.89974 0.97994 0.99989 0.79981 4.80926
9 jista 0.69989 0.69997 0.74998 0.69997 0.69922 0.69989 0.73997 0.99789 0.59985 0.37310
G st -0.28440 -0.10035 -0.10093 -0.10013 -0.10274 -0.10011 -0.20049 -0.20014 -0.10035 27.3163
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A15197 5.5 LlﬁﬂQf’]l”lﬂ’J”liJﬂa”lﬂlﬂﬁﬂuﬂlﬂﬂll‘UU55”Ia@m”lﬂﬂiﬁ@]ﬁ”lﬁ@]giﬂﬂ%umagaﬂ@%ﬁlﬂlﬂﬂNﬁﬂ"li‘l/]ﬂﬁ’f]ﬂ‘ﬁ 2

UUAN . MANUAINANDDY (%)
- nanms
2aNdINY GA1 GA2 GA3 GA4 GAs GA6 GA7 GA3 GA9 GA10
Useans 20 50 100 200 300 50 50 50 50 50
Tasus
79U 10,000 10,000 10,000 10,000 10,000 15,000 20,000 30,000 40,000 50,000
Sum Square 8.7694 8.7692 8.7251 8.6851 8.6642 8.6670 8.6290 8.6278 8.8316 9.4585
Preheating Zone
Mean 3.0029 3.0025 2.9237 2.7746 2.6854 2.7313 2.5929 2.5857 3.0932 1.2757
Sum Square 11.823 11.829 11.504 11.216 11.194 11.025 10.826 10.775 12.157 5.8370
Heating Zone
Mean 7.2293 7.2295 6.8621 6.5153 6.5035 6.2799 6.0460 6.0021 7.5578 0.2603
Sum Square 10.305 10.305 10.171 10.044 10.003 9.9664 9.8629 9.8213 10.504 5.8028
Soaking Zone
Mean 1.7883 1.7889 1.6945 1.5015 1.4672 1.4289 1.3175 1.2910 1.7992 0.5975
2 ' ) ' v v =
AITNN 5.6 LAAIAIAITNIANNIDULATATNIUATUNMUATINIDUUDINANTTNANDIN 2
aunls GAl GA2 GA3 GA4 GAS GA6 GA7 GA3 GA9 GA10
Rl (OC / W) 0.00597 0.00569 0.00539 0.00531 0.004793 0.004579 0.00438 0.00462 0.00427 0.00397
R2 (OC/W) 0.00385 0.00342 0.00324 0.00319 0.00288 0.00275 0.00263 0.00277 0.00256 0.00239
R3 (OC/W) 0.00498 0.00479 0.00449 0.00443 0.00399 0.00382 0.00366 0.00385 0.00361 0.00331
Cl (J/OC) 122,189.4 128,018.0 136,134.0 129,247.8 134,033.0 150,569.2 147,964.1 140,599.2 169,343.5 105,297.9
C2 (J/OC) 50,292.89 52,689.88 53,452.65 49,098.47 54,592.79 55,221.02 55,809.12 52,785.59 68,006.97 42,765.99
C3 (J/OC) 11,167.00 11,700.00 11,700.00 11,884.74 13,177.89 13,371.43 13,620.90 12,987.00 17,121.95 9,310.61
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%These Program is used to Open-loop Identification for Reheating Furnace Walking Hearth Type
in Heating Curve Up Process
% Program with Parinya Trakunvongngam
% Write on Matlab
% November 2010
RS (a1t Programy F R R R R R R R
%(Objective function)
function f=CONST _1(x)
x=[0.0140906351609181 0.505932481436202  0.107607175523529  0.820709608040855
0.621138617456738 0.169089603557579]; %(Parameters Estimated)
clear all
cle
Y%Initial Condition of Temperature
exit(1)=30;
t1(1)=32;
t2(1)=26;
t3(1)=24.92;
%Import Output Data(Actual Data)
load exit
load preh
load heat
load soak
Y%Import Input Data
load input_step2
%import Heating up curve
load heatl
%import time in process
load timerunl
Y%reset error

sum_error=0;
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sum_error1=0;

sum_error2=0;

sum_error3=0;

%Process Step size = 1 only

for i=1:3300
stttk okl Q[ TRk ook ok ok ke e e e
%State-Space for Preheating Zone in Time domain

t1GE+HD=tIO)+H-(((x(1)+x(2))*107-2)*t1 (i) )+(x(2) * 107~

2)*12(1))+((x(1)*1072) *exit(i))+(x(7)*10-2);

%State-Space for Heating Zone in Time domain

2+ 1)=t2()+((x(3)*107-2)*t1()-((x(3)+x(4))*10"-2)*t2(1)+(x(4)*10"-2)*t3(1))+(x(8) *107-2);
%State-Space for Soaking Zone in Time domain

t3G+1)=t3()+H((x(5)*107-2)*12(1)-(x(5)* 107-2)*t3(1))+((x(6)* 10”3 ) *input_step2(i))+H(x(9)*10"-2)
stttk ook ook ook ook okt [T Rttt otk ko s e ok
%Sum square error in for Preheating Zone
sum_errorl=sum_error1+((t1(i)-preh(i))*100/preh(i))"2;

%Sum square error in Heating Zone

sum_error2=sum_error2+((t2(i)-heat(i))*100/heat(i))"2;

%Sum square error in Soaking Zone

sum_error3=sum_error3-+((t3(i)-soak(i))*100/soak(i))"2;

%Sum of error

sum_error=sum_error+sum_errorl+sum_error2+sum_error3;

end

f=sqrt(sum_error/3301);

return
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% These Program is used to Burner Design for Reheating Furnace Walking Hearth Type in
Heating curve Up Process

% Program with Parinya Trakunvongngam

% Write on Matlab

% November 2010

*****************************Start Program**************************************
%0bjective Function

function f=test4 2(x)

% Number of Burner in Digital Logic Term

(=]

x<0 001 01 000010000010010011000T10

(=]

100001 000000O01100000110011T100°1
110111001001 10110000100010011T11
101111110101 101110001T1010100T1T1:1
6001101011110 1]

cle

clear all

%Initial Condition of Temperature

exit(1)=30;

t1(1)=32;

t2(1)=26;

t3(1)=24.92;

YRk ek ks Tmport Output Data(Actual Data) at step size 300%# stk itk
load stepl

load step2

load step3

load step4

load step5

load step6

load step7

load step8
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load step9

load step10

load stepl1

load step12

ks KR SRR SRR SRR R SRR R SRR K SRR SRR KR SRR SRR R KSR R SRR R SRR K
Y%Import time in process at step size =1

load timerunl

%Import Heat up curve, Reference Data

load heatl

% Reset error

sum_error=0;

sum_error1=0;

sum_error2=0;

sum_error3=0;

sum_error4=0;

sum_error5=0;

sum_error6=0;

sum_error7=0;

sum_error8=0;

sum_error9=0;

sum_error10=0;

sum_errorl1=0;

koo oo Number of Burner in Logic Term st sttt ook ok
yI=x(DHx(2)+x(3)+x(4)+x(5)+x(6)+x(7)+x(8)+x(9)+x(10);
y2=x(11)+x(12)+x(13)+x(14)+x(15)+x(16)+x(17)+x(18)+x(19)+x(20);
y3=x(21)+x(22)+x(23)+x(24)+x(25)+x(26)+x(27)+x(28)+x(29)+x(30);
y4=x(31)+x(32)+x(33)+x(34)+x(35)+x(36)+x(37)+x(38)+x(39)+x(40);
y5=x(41)+x(42)+x(43)+x(44)+x(45)+x(46)+x(47)+x(48)+x(49)+x(50);
y6=x(51)+x(52)+x(53)+x(54)+x(55)+x(56)+x(57)+x(58)+x(59)+x(60);
y7=x(61)+x(62)+x(63)+x(64)+x(65)+x(66)+x(67)+x(68)+x(69)+x(70);

y8=x(71)+x(72)+x(73)+x(74)+x(75)+x(76)+x(77)+x(78)+x(79)+x(80);
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y9=x(81)+x(82)+x(83)+x(84)+x(85)+x(86)+x(87)+x(88)+x(89)+x(90);
y10=x(91)+x(92)+x(93)+x(94)+x(95)+x(96)+x(97)+x(98)+x(99)+x(100);
y11=x(101)+x(102)+x(103)+x(104)+x(105)+x(106)+x(107)+x(108)+x(109)+x(110);

>k sk ok ok ok ok sk ok sk ok sk sk ok sk sk ok ok ok sk sk ok sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk ok sk sk skoskosk sk sk sk sk sk sk sk sk sk sk sk ko ko kol ke kol ok kek ko kel sk skekokok

%use mean parameter from Parameter Identification

for i=1:3300

if i>=1 && i<=300
t3(i+1)=t3(i)+((1.35582612523341*10"-2)*t2(1)-(1.35582612523341*10"-2)*t3(i))
+((0.000325758401488253*1073)*y1)+(-0.986656886739073*10"-2);
t2(i+1)=t2(1)+((0.553234092017852*10"-2)*t1(i)-
((0.553234092017852+1.22086114633253)*10"-2)*t2(i)+(1.22086 114633253 *10"-
2)*t3(i))+(0.393010842437730*10"-2);
t1(+1)=t1(i)+(-(((0.398634549364845+0.287657702289112)*10"-2)*t1(i))
+(0.287657702289112*10"-2)*t2(1))+((0.398634549364845*10"-
2)*exit(i))+(0.509475677233195*10"-2);

sum_errorl=sum_error1+((t3(i)-step1(i))*100/step1(i))"2;

elseif i>=301 && i<=600
i=i-300;

3G+ 1)=t3(1)+((1.35582612523341*107-2)*2(1)-(1.35582612523341*10"-2)*3(i))
+((0.000325758401488253*10°3)*y2)+(-0.986656886739073%10"-2);
£2(i+1)=t2(1)+((0.553234092017852*10"-2)*¢1(i)-
((0.553234092017852+1.22086114633253)*107-2)*t2(i)+(1.22086 1 14633253*10"-
2)*3(1))+(0.393010842437730%10-2);
£1G+1)=t1(D)+(-(((0.398634549364845+0.287657702289112)*10"-
2)*t1(1))+(0.287657702289112%10/-2)*t2(1))+((0.398634549364845%10-
2)*exit(i))+(0.509475677233195%107-2);

sum_error2=sum_error2-+((t3(i)-step2(i))*100/step2(i))"2;
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elseif >=601 && i<=900

i=i-600;

3G+ 1)=t3(1)+((1.35582612523341*107-2)*2(1)-(1.35582612523341*10"-2)*3(i))
+((0.000325758401488253*10°3)*y3)+(-0.986656886739073%10"-2);
£2(i+1)=t2(1)+((0.553234092017852*10"-2)*¢1(i)-
((0.553234092017852+1.22086114633253)*107-2)*t2(i)+(1.22086114633253*10"-
2)*3(1))+(0.393010842437730%107-2);
£1G+1)=t1(D)+(-(((0.398634549364845+0.287657702289112)*10"-
2)*t1(1))+(0.287657702289112%10/-2)*t2(1))+((0.398634549364845%10-
2)*exit(i))+(0.509475677233195%107-2);

sum_error3=sum_error3-+((t3(i)-step3(i))*100/step3(i))"2;

elseif >=901 && i<=1200

i=i-900;

3G+ 1)=t3(1)+((1.35582612523341*107-2)*2(1)-(1.35582612523341*10"-2)*3(i))
+((0.000325758401488253%10/3)*y4)-+(-0.986656886739073%10"-2);
£2(i+1)=t2(1)+((0.553234092017852*10"-2)*¢1(i)-
((0.553234092017852+1.22086114633253)*107-2)*t2(i)+(1.22086 1 14633253*10"-
2)*3(1))+(0.393010842437730%10-2);
£1G+1)=t1(D)+(-(((0.398634549364845+0.287657702289112)*10"-
2)*t1(1))+(0.287657702289112%10/-2)*t2(1))+((0.398634549364845%10-
2)*exit(i))+(0.509475677233195%107-2);

sum_errord=sum_errord+((t3(i)-step4(i))*100/step4(i))"2;

elseif i>=1201 && i<=1500

i=i-1200;

33+ 1)=t3()+((1.35582612523341*107-2)*t2(1)-(1.35582612523341*10"-2)*3(i))
+((0.000325758401488253*1073)*y5)+(-0.986656886739073*10-2);
2(i+1)=t2(1)+((0.553234092017852*10"-2)*t1(i)-
((0.553234092017852+1.22086114633253)*10/-2)*t2(i)+(1.22086114633253*10"-

2)*t3(1))+(0.393010842437730*10"-2);
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t1(i+1)=t1(1)+(-(((0.398634549364845+0.287657702289112)*10"-
2)*t1(i))+(0.287657702289112*107-2)*t2(i))+((0.398634549364845*10"-
2)*exit(i))+(0.509475677233195*%10"-2);

sum_error5=sum_error5+((t3(i)-step5(i))*100/step5(i))"2;

elseif i>=1501 && i<=1800

i=i-1500;

133+ 1)=t3()+((1.35582612523341*107-2)*t2(1)-(1.35582612523341*10"-2)*3(i))
+((0.000325758401488253*10"3)*y6)+(-0.986656886739073*10-2);
2(i+1)=t2(1)+((0.553234092017852*10"-2)*t1(i)-
((0.553234092017852+1.22086114633253)*10/-2)*t2(i)+(1.22086114633253*10"-
2)*3(1))+(0.393010842437730%107-2);
t13i+1)=t1()+(-(((0.398634549364845+0.287657702289112)* 10
2)*t1(1))+(0.287657702289112*10"-2)*t2(i))-+((0.398634549364845% 1 0
2)*exit(i))+(0.509475677233195%107-2);

sum_error6=sum_error6+((t3(i)-step6(i))*100/step6(i))"2;

elseif i>=1801 && i<=2100

i=i-1800;

£33+ 1)=t3(1)+((1.35582612523341%107-2)*2(1)-(1.35582612523341*10"-2)*{3(i))
+((0.000325758401488253*10°3)*y7)+(-0.986656886739073%10"-2);
t2(i+1)=t2(1)+((0.553234092017852*10"-2)*¢1(i)-
((0.553234092017852+1.22086114633253)*107-2)*t2(i)+(1.22086114633253*10"-
2)*3(1))+(0.393010842437730%10-2);
t1(i+1)=t1(1)+(-(((0.398634549364845+0.287657702289112)*10"-
2)*t1(1))+(0.287657702289112%10/-2)*t2(1))+((0.398634549364845%10-
2)*exit(i))+(0.509475677233195%107-2);

sum_error7=sum_error7+((t3(i)-step7(i))*100/step7(1))"2;
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elseif >=2101 && i<=2400

i=i-2100;

133+ 1)=t3()+((1.35582612523341*107-2)*t2(1)-(1.35582612523341*10/-
2)*t3(1))+((0.000325758401488253%10"3)*y8)+(-0.986656886739073*10"-2);
2(i+1)=t2(1)+((0.553234092017852*10"-2)*t1(i)-
((0.553234092017852+1.22086114633253)*10/-2)*t2(i)+(1.22086114633253*10"-
2)*t3(1))+(0.393010842437730%10"-2);
t13i+1)=t1(I)+(-(((0.398634549364845+0.287657702289112)* 10
2)*t1(1))+(0.287657702289112*107-2)*t2(i))+((0.398634549364845% 1 0
2)*exit(i))+(0.509475677233195%107-2);

sum_error8=sum_error8-+((t3(i)-step8(i))*100/step8(i))"2;

elseif i>=2401 && i<=2700

i=i-2400;

33+ 1)=t3(1)+((1.35582612523341*10"-2)*(2(i)-(1.35582612523341*10"-2)*13(i))
+((0.000325758401488253%10"3)*y9)+(-0.986656886739073*10"-2);
12(i+1)=t2(i)+((0.553234092017852*10"-2)*11(i)-
((0.553234092017852+1.22086114633253)*107-2)*t2(i)+(1.22086114633253*10"-
2)*3(1))+(0.393010842437730*10-2);
t1(3i+1)=t1(i)+(-(((0.398634549364845+0.287657702289112)*10"-
2)*1(1))+(0.287657702289112*10-2)*t2(i))+((0.398634549364845*1 0
2)*exit(i))+(0.509475677233195%107-2);

sum_error9=sum_error9-+((t3(i)-step9(i))*100/step9(i))"2;

elseif >=2701 && i<=3000

i=i-2700;

133+ 1)=t3()+((1.35582612523341*107-2)*t2(i)-(1.35582612523341*10"-2)*t3(i))
+((0.000325758401488253*10/3)*y10)+(-0.986656886739073*10-2);
2(i+1)=t2(1)+((0.553234092017852*10"-2)*t1(i)-
((0.553234092017852+1.22086114633253)*10/-2)*t2(i)+(1.22086114633253*10"-

2)*t3(1))+(0.393010842437730*10"-2);
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t1(i+1)=t1(1)+(-(((0.398634549364845+0.287657702289112)*10"-
2)*t1(i))+(0.287657702289112*107-2)*t2(i))+((0.398634549364845*10"-
2)*exit(i))+(0.509475677233195*%10"-2);

sum_errorl0=sum_error10+((t3(i)-step10(i))*100/step10(i))"2;

else

j=i-3000;
t3(i+1)=t3(i)+((1.35582612523341*10"-2)*t2(1)-(1.35582612523341*10"-2)*t3(i))
+((0.000325758401488253*1073)*y11)+(-0.986656886739073*10"-2);
t2(i+1)=t2(1)+((0.553234092017852*10"-2)*t1(i)-
((0.553234092017852+1.22086114633253)*10"-2)*t2(i)+(1.22086 114633253 *10"-
2)*t3(i))+(0.393010842437730*10"-2);
t1(i+1)=t1(i)+(-(((0.398634549364845+0.287657702289112)*10"-
2)*t1(1))+(0.287657702289112*10"-2)*t2(i))+((0.398634549364845*10"-
2)*exit(i))+(0.509475677233195*10"-2);
sum_errorl1=sum_errorl1+((t3(i)-step11(i))*100/step11(1))"2;

end

end

%Sum of error
sum_error=sum_error+sum_errorl+sum_error2+sum_error3+sum_errord+sum_errorS+
sum_error6+sum_error7+sum_error8+sum_error9+sum_error10+sum_errorl1;
f=sqrt(sum_error/3301);

return
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Number of Burner
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@ - @ ﬁ ‘ ‘ Stack:: Base ~ ‘ @ Select data to plot v
Name ~ Value Min Max

EB Templ <3301x1 double> 249200 819.97...

EB Temp2 <3301x1 double> 25.4535 739.56...

EB Temp3 <3301x1 double> 27.4052 43598...

FH Tout <3301x1 double> 0 3300

A )
31]1’] 4.3 LEAILNUNTNY ayammauau@ﬂu Work Space
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412 &4Plot N9 Command Window 9% 18 n31wwan1saouaues nandagili 44

>> plot(Tout, Temp1,Tout, Temp2,Tout, Temp3)

1000

800

600

Temperature (Degree C)

0 500 1000 1500 2000 2500 3000
Time (min)

U9 9.4 nEraHUN NG 03 AN 1AV AUDIVO T 1801

14 aNuus 1009e9szun Iaen wuad wlsuasaie ud e sn s nd eans

T Tsunsuilszanamdauls uaasd agii s

B idenl_nonlinear * Sl

File Edit View Simulation Format Tools Help

DSE& Bl&2 4o = 3300 [Nomal N BERes RhEE®

Step3

m—'_’ :
+
Stepé

Steps

Step1

Ready 100% oded5

JUN 4.5 uaAuHUNNIUDT 189952 UDIN9 1 TU Simulink
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a5 idein1sAna b ¢ d e fuAdessvuaaiz udulumslszana
(@onAwuugw) laes mualia=001 b=3 c=1 d=1e=1 f=0.2ua2 fi 11UA Sampling=13117
SAuMS U upoudt 1| M3f MUASTCommand Window &0
>>a=0.01;
>>h=3;
>>c=];
>>d=1;
>>e=];
>>f=(.2;
Click Run 4 oyagnuaninail Scope uazoyagnii1 11 Work Space ¥o TT!
TT2 TT3 M8 19 Ud 9Plot 114 Command Window 2 18 n31msneveaies uaméﬁgﬂﬁ 4.6

>> plot(Tout, Temp1,Tout, Temp2,Tout, Temp3,Tout, TT1,Tout, TT2, Tout, TT3)

1000 g
Data of Experiment T'1
Data of Experiment T2
800~
Data of Experiment T3
""" Data of model T'1
0 | | T
%81) 600 ata of mode
5 """" Data of model T3
>
2
%’ 400
=
200
0
0 500 1000 1500 2000 2500 3000
Time (min)

JU7N 1.6 uaAwEUMNATEUNEUNIADUAUBIVDINITT 1009
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a1.4  Wanii1e19 Parameter Estimation 910 Iden1 nonlinear Tagaon tools =>

. . Y 1 dydy [ A
Parameter Estimation 91/310)1111¢11911 3 ua uaasn 131l 1.7

WA Control and Estimation Tools Manager (=/@] % |
File View Help
dDégd|@
‘ Workspace Task settings
=) ﬂ Project - idenl_nonlinear | | Tiyje:
E _
Transient Data Subject:
f mVariables
Author:
| (& Estimation
g Validati Company
i
Description: =
Model: idenl_nonlinear Open Model ] [ Update Task ]
Select the nodes below to configure and run estimati :
J

517 9.7 uaa kNN 1A 19UD9 Control and Estimation Tools Manager

. A . 1% ~
3.1.5  Click ta®n Transient Data => New LLGAA Qgﬂ‘ﬂ 3.8

‘ Workspace Transient data sets
£ Project - idenl_nonlinear <
=] Estimation Task Naine Rropeties
5
¢ Ea Variables
(8} Estimation

o3

Descriptidn;

] = [ =

|Transient data sets are stored in this folder. Press 'New’ to create a new data set

19 9.8 nEraaHUN NN IA19W09N151000 New Data
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4.1.6  Click New Data => Output Data => Import 1018009 03210 W WATT1 TT2 TT3

1oz Tout UEAIA131N 4.9

B Control and Estimation Tools Manager

Import from: Workspace '}

File View Help

e Variable Name  Size  Bytes  Class
ghjed ‘ B 33011 26408 double
4\ Workspace ) | Input Data| Output Data | State Datal 33011 26408 double
& B Project - idenl_nonlinear | o "o biocks 3301 26408 double
=3 Estimation Task

E-U7) Transient Data Block Name Data Tixe / Ts SEIFS| AT COrih
32! iden1_nonlinear/Out1 . n 8 daubls
[ Variables Channel -1 [ L el ToutgA) [ 1x1 8 double
(&} Estimation iden1_nonlinear/Out2 | 1 8 double

(g validation Channel -1 TT261) * ] Tout())  / 191 2 doubia @

iden1_nonlinear/Out3

Channel -1 | 11361 K @ Assign the following columns to selected chann

(©) Assign the following rows to selected channel(s)

[ Import... ] [ Pre-process... | [ Import ] [ Close ] [ kielp, ]

-New Data to Transient Data.

Select the tabbed panels to configure the transient data set.

=i Y A v s
gﬂ“ﬂ 4.9 LEAIHNUNTINUUINTNNITIaDNU ’63;!?1’0']@1’!@]

917 Click Variables => Add => fond 1lsnd osmstlszanmar=> OK w31 a.10

—
8] Controland Estmation Tools Manager ™ %

File View Help

dD|Egd|®

‘ Workspace
=] ﬂ Project - idenl_nonlinear
=2y Estimation Task
-4 Transient Data
- “[#] New Data

m (& Estimation
Ea Validation

Eeti 4P

Esti d States

Selected parameters

Specify expression (e.g., s, a(3), b{2}):

e | K |

~New Data node has been added To Transent Data. ok J[ Con.. |[ hHep |[ appy |

Select the tab panels to configure your estimation parameters and states.

=i Y A o A Y
gﬂ“ﬂ .10 LEAAUDTINUUINTNNITIADNA ’JLL“]J%"VI@] ’P)\iﬂ'liﬂi%ll'lil!
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4.1.8  Click Estimation => New 9215101111619 New Estimation 1aaa 9317 .11

File View Help

506 d|@

4\ Workspace
-8 Project - idenl_nonlinear
=34 Estimation Task
& {3 Transient Data
- [#] New Data
[ Variables

A Estimation|
o B vadston

Estimations

Name

Properties

Description:
™~

I New ” Delete J[ Edit... ]

- New Data node has been added to Transient Data.

File View Help

D& a|E

[ Validation

< n »

| 4\ Workspace Data Sets I P; ] Stausl Esti !
=8 Project - idenl_nonline; | 1.\, (ets used for estimation Output data weights
=E)E Task

- Transient Data || LT ) | | [ BlockName | Length
~ [#] New Data iden1_nonlinear/Out1

- Variables Data Set Seleced Channel-1 | 3301/3301 |

[ Estimation #|  liden1_nonlinear/Out2
Channel -1 | 3301/3301 |
- @@ views iden1_nonlinear/Out3

Channel-1 | 3301/3301 |

Select the tab panels to configure your estimation.

U

517 @12 namswunmriiaensiaend eya lunialszunua
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4.1.10  Click Parameters => Click 190 Estimate 9)n@A2114)5 naaagih .13 uaz
Click Estimation => Estimation Option (e 1vuadanesnulun1sdseuianidinys

Hanea 3N 9.14

N File View Help
gD ad|E
[#: Workspace Data Sets| P et IStatesI" :
-8 Project - iden1_nonline{
Er" imation Task
ElTransient Data Name Value ﬁmate Initial Guess Minimum  Maximum  Typical Va...
1

Estimation paramet

[ NewData Inf +Inf a
[ Variables E -Inf +Inf

- [& Estimation g -Inf +Inf

b
c
i -Inf +Inf d
G2 views 9 Inf “Inf e
m Validation v f

/ m "G

Use Value as Initial Guess ] [ Reset to Default Settings ] [ Save as Default Settings ]

FW.

Select the tab panels to configure your estimation.

[ a Y
A ulsisua

~ Y o (% A9
g'ﬂ‘ﬂ 313 UEAUNUNNHUIANMTA 1M UaA Wl sNA oI5 dszanu

8 Conrolna Esmation oo Wiamger® 0 0~ = = o8] =
File View Help

g0 &d|@

L\ Workspace | Data Sets | P [ states| Estimati 'l

- g J.-em- 3 Id.enlfr:::hrlt Estimation progress \
-UE) Transient Data Iteration Function... CostFun... Step Size
- [t New Data
¢ mVariabIes
- [&) Estima

- @02 Vie| || Simulation Options| Optimization Options | Parallel Options
3| Optimization method

Method: | Nonlinear least squares V] Algorithm: [TrusbRegion-Reflective V]

Optimization options

Diff max change: 01 Maximum fun evals: [400 ‘

Diff min change: [1:-008 [ Maximum iterations: 100 j
Parameter tolerance: |0.001 J Function tolerance: l0.001 l
Display level: [ Off M) Gradient type: ‘ Basic ~7 ]
Cost function: SSE | ["] Use robust cost

o) [camea ] (o] (owt ]

d‘ Y o [ a R [
gﬂ‘ﬂ 314 LEAUHUNINHITIA19NTA 11 UAD anes Ny lumsUszanuaia s
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34.1.11 Click Estimation => Show Progress Views => Start Llﬁﬂiﬁligﬂﬁ .15 waznil

HaNFABLAUDINNAFUTzaaA A Ll afeun UV 018010 WA Texp! Texp2 Texp3 e 33107 116

CECETEmnr s R N )

| File View Help
dh|égd|@
4\ Workspace | Data Sets | Parameters | states| Estimation I
-l Project - idenl_nonline e
= il Estimation progress
& Estimation Task
=] Transient Data Iteration Function ... CostFun... Step Size Procedure Estimation Options...
“[1#]] New Data - - -
[ Variables Display Options...
&-[& Estimation
[ views =
33 validation =
< m ] »
“New O s : = ’||
Select the tab panels to configure your estimation. 4

d' Y q' LK%
gﬂ‘ﬂ 315 UEAUNUNMNHUIA1NMTE UM sdszanuaia s

1000 T T ! ! ! !

1000 1 T 1 T 1 T

Temperature (degree C)

0 500 1000 1500 2000 2500 3000
Time (min)

g1 116 namauEuNMHANIsABDALBIINMIUsEMMA M sIReUT UY ayae1A YA
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1,12 Click Parameters tivogaa st Tusunsuilszana 1@ naasdazili a.17 vaz

taauFauMeun UAIR 5959 LEAIA 9915197 4.1

W Control and Estimation Tools Manager =8
File View Help
gned
4\ Workspace [ Data Sml Parameters [ Statesl e ]
=] _J"’Jed.' |d.en1_nonlmear RO
2] Estimation Task
L[ Transient Data Name Value Estimate Initial Guess  Minimum  Maximum  Typical Va...
|
4] New Date s 00083864 -\ [¥] B -Inf +Inf a ‘
[ Variables b w2 || @ b -Inf +Inf b |
& (8 Estimation c 078089 | @) c -Inf +Inf c
6 New Estimation | |4 09663 | [ \ d -Inf oinf d
=03 Views . 07205 \ e -Inf +Inf e
¥ Default View | [ 014266 [\ f Inf +Inf f ‘
@-[g Validation \ ‘
Use Value as Init~= \ — Save as Default Settings
< m | » 1 4
Anlszinadnls
Starting Estimation. .. =

Select the tab panels to configure your estimation.
n

— A

51U 0.17 naasuwunmad s Tudsunsuilszana 1a

A1319% 4.1 saasad s 1d mnmsdszsnanSsumeus ua1asa

aauls 16 15959 amszanaa s
a 0.0088864 0.0088864
b 2.94120 2.94120
c 0.78088 0.78089
d 0.96634 0.96633
e 0.72051 0.72050
f 0.14266 0.14266
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2 ay
" W ~ 9 =N 9 ] 1 a = Y A Y
aduinlannmsdszanaii lnd fenva1vswesszund sz 15isedoyavos
< T W 9 @ 1 a a
MIinaasdnausalszuaaiaanilsld andregenanaasulssansainuea Tlsunsy
L2 o r'd 1
Parameter Estimation 1M 3dszinaaia s Tunss 100 @0 1umsslvenszuiunsguia,
a § o L 1 o o a 4
puwadle Feaziiuer lldsegndldlumalssanuaidnlsvewnus mesnenaamans

v < a v
YOINTZUVIUMIQUIA1 LA UIMANYTIA Walking Hearth @0 11/
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2 =
2.1 mslglilsunsuduu@ndana3niwes MATLAB
o 9 Y
11,1 deyaINN1sNAaos (Import Data) 1314 Work Space vodlisuns
MATLAB ualumisuaasdiedransldauszadaunusiassvesszuulasly M-file lu
0 0 o ' o 9 Ay g o
MARUIN ¥ 1058 mueanlsuazavesdndsvesszuuas il Taedoyan ldninnissu
a g W g o <
Tsunsueuindudoyaninnisnaasy TsunsuiiunissiaesssuumwuHan
= A a I Y Ao I a 03} Y v A
suuruta Taslisuwailuinalianyuzifludunanuniduiiule naaeaegl 0.1 nag
AIMUAAL X, = 0.0140906 X,= 0.5059324 x,= 0.1076071 x,= 0.8207096 x,= 0.6211386
x,= 0.1960896 1Az Sampling = 1 3117 W5 uTUsunsudoyansaevduegnueasli Work Space

eraIna31li 9.2

11

10

Number of Burner

0 500 1000 1500 2000 2500 3000
Time (min)

v £
319 .1 naaswun g oyaduauuul uiula



EE AR LY Stack:t Base ~ \ 4D Select data to plot

Name ~ Value
FH <3301x1 double>
HH 2 <3301x1 double>
HH 3 <3301x1 double>
Ea timerunl <3301x1 double>

Min Max

249200 805.87...
253925 739.44..
25.8335 433.54..
0 3300

19 9.2 uaaswun My oyanisaeuaue el Work Space
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.12 @9Plot 19 Command Window ¢ 18 ns1lwamsaeuaues naadgii 9.2

>> plot(timerunl,t1,timerun1,t2,timerun1,t3)

Temperature (Degree C)

1000

800
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400
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0 500 1000 1500
Time (min)

gﬂﬁ 2.3 UEAAILNUNWHANTADUAUDIVBILUUY 1209
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J

113 afwaumsiaguszeasd Tu M-file voa Tsunsu MATLAB luiidl Aeslandu

Y
[ J

1 v Y
CONST 1 ugaslumanuin v Falsnruiaguszaedt danmlsideamsmiam e 6
@ =
Gl’JLLﬂiﬂ@ X, X, X3 X, X5 X
= I
.14 mMsisenld Genetic Algorithm tool W30 GAT 1Wu GUI (Graphic User Interface)
Nl emnsal¥Ga 18 Taglid 0414 & 1d 99nd S o5 U 18(Command Line) Tumsitla 4 a1y

GAT 11114 Tagnsisond 18 s lumii i1 Command Window 921/510511i 19119 GA tidaea 13107 9.4

>>gatool

P
4\ Optimization Tool

Problem
Fitness function:

Number of variables:

B %
File Help
Problem Setup and Results Options.
r 5 : 1 ~||l_E Population ]
Solver: | ga - Genetic Algorithm Nl

Population type: Double Vector
Population size: @ Use default: 20
) Specify:

Creation function: | Use constraint dependent default

Constraints:
Linear inequalities: A b:
Linear equalities: Aeq: beq: Initial population: © Use default: []
Bounds: Lower: Upper: © Specify:
Nonlinear constraint function: Initial scores: © Use default: [] -
Run solver and view results = © Specify:
Use random states from previous run Initial range: © Use default: [0;1]
Pause Stop © Specify:
Current iteration: Clear Results [ Fitness scaling )
[ Selection ]
Reproduction ]
Mutation LY
[ Crossover ]
Migration ]
v Algorithm settings ]
Final point: ‘ = =
i | - (B Hybrid function ) -

U9 .4 uaauwuMNINIA1UD GAT




9.1.5

mslawanFut Glfqﬂi L AR (Fitness Function)

127

WUNAIT9@ CONST 1 1u%04 Fitness Function #ags1u3ududlsluyeq

Number of variables LEAA 33 17 2.5

4 e

EEL

a

519 2.5 uaasuwunmms lastas Fu

[# Hybrid function

File Help
[ Problem Setup and Resuts Options =2
" Solver: | ga - Genetic Algorithm = 4 {2 Bepulation E ]:‘
i Prof Population type: | Double Vector v}
mm [@consT 1 | Population size: @ Use default: 20
Number of variables: 6| > | © Specify: | |
e Creation function: ; Use constraint dependent default V}
Linear i liti A *w b: [7\
Linear equalities: Aeq: —| beq: ‘—\ Initial population: © Use default: []
Bounds: Lower: Upper: [ \ © Specify: \ ‘
Nonlinear constraint function: ‘ Initial scores: © Use default: [] 3
Run solver and view results £ © Specify: l ‘
["] Use random states from previous run Initial range: © Use default: [0;1]
[Lsta ] [ Ppause stop | © specify: | ]
Current teration: | | [ Clear Results Fitness scali )
 Selection ]
 Reproduction )|
[# Mutation )3
Crossover ]
Migration )
v || [L_® Algorithm settin |
Final point: )

[ o o (Y
Talszasauazs 1R s

Q
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1.6 M3latiuaudszying (Population Size) Tae'ldan Option => Population
o A& o v Y o v v v o gy
Tﬂillﬂilﬁ]%ﬂ THHAATWUITUY ']‘L!'J‘lﬂigah"lﬂiellfl\?ﬂ'liﬂuﬁ’llﬁlfﬂ’lﬂﬂ 20 91909M5U5SUN 'Iulﬂ

Taeidon Population Size => Specify 118 25213 1WIUIAAIA 31N 9.6

Options >>
[ S| Popl}l@tion ]

Population type: :DoubleVector

_) Use default: 20

9@ Specify: 100|

Creation function: | Use constraint dependent default

Initial population: @ Use default: []

) Specify:
Initial scores: 9 Use default: []
) Specify:
Initial range: Q) Use default: [0;1]
Specify:

19 0.6 naaswunmms lasszannsvoanss um

217 MsAMuedItmsAaaena1ewus (Selection) Iagli#i Option => Selection
AAas ~ a0 ast v o [ an
1smsdenszrnsgnraruinaie sy 3501590 UAU (Rank) 51T 1ug1unY (Uniform)
ad o Y an <] an J @
AB9ANITUUIY (Tournament) 15909294 031aN (Roulette) 1Az Asmsguilunsouinsaa

(Stochastic universal) LEAI9 33 1N 2.7

[=] Selection |

Selection function: | Stochastic uniform

Stochastic uniform

Remainder
Uniform
Roulette
Reproduction | Tournament '
| Mutation Sustom

3191 9.7 uaaamunIMMI@DN Selection
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2.1.8  MIAIMUAT IUIUTOVVBINMTA UK A M UARIANNAIIARdoUT1 1A 1ag
1 Option =>Stopping criteria => Generations O IMUATINIUTOY AvuarIwIallu
M3AU111AY Option =>Stopping criteria => Time limit f 1MUAT WIUTOUNTA 1MOUAUANILE 2
‘Hfmﬁ 191U lag Option =>Stopping criteria => Stall Generations A 1M UAAIAINADIAAADUUD

Ao Tay Option => Stopping criteria => Function tolerance LLe¥ AIA Qgﬂ”ﬁ 9.8

rB Stopping criteria ]

Generations: Use default: 108

® Specify: 30000|
Time limit:

TIUIUTOVUON

v
NMIAUNI

Fitness limit: @ Use default: -Inf

Specify:

Stall generations: Use default: 50

@ Specify: | inf

FIHIUTOUNA 19OV

517 2.8 llﬁﬂﬂlmuﬂ'lWﬂ'lilﬁﬂﬂ‘ﬁ'lu’J‘L!i@ﬂlla$ﬁ1ﬂa1ﬂlﬂﬁﬂuﬂl’6\1ﬂ1iﬁ}uﬂ1

U

9.1.9

Stall time limit:

Function tolerance:

Nonlinear constraint tolerance: @ Use default: 1e-6

@ Use default: Inf

Specify:

td
4 wdrgn

© Use default: 1e-6

Specify:

Specify:

' 4 A
ANALAADUN

gousuld

' o J J v = .
msuaasnsivesndmlsuazarveslentu Taoi@on Option => Plot

Function => Best fitness (1% Best individual Llﬁﬂﬂﬁﬁgﬂﬁ 2.9

[ =] Plot functions

Plot interval: 1
V| Best individual [ Distance
| Expectation ["] Genealogy ["]Range
[7] Score diversity [7] Scores [ Selection

|| Stopping

| Custom function:

| Max constraint

=i A v
TlJ‘V] 2.9 ll’ﬁﬂ\ilmuﬂ'lWﬂ'lim@ﬂLL'ﬁﬂ\?ﬂi'l‘V\lﬂl'O\?ﬂ'liﬂ UK

U
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9.1.10 Click Start 101013565 1 T5unsIMsA um uaasasgilii v.10 Tasvzudansivl

Matlszananvesd s uaaeaagin o.11

4\ Optimization Tool (=[@] = ]
File Help
|| Problem Setup and Resuits Options
Solver: | ga - Genetic Algorithm = |4 [ Population )
Problem " | |L_= Fitness scaling )
Fitness function: @CONST_1 Selection ]
Number of variables: |6 [ Reproduction ]
Mutation ]
Constraints:
- Crossover )
Linear inequalities: A b:
3 & Migration )
Linear equalities: Aeq: beq:
7 il = & Algorithm settings ]
Bounds: Lower: L Upper: & fnction ]
Nonlinear constraint function: | T ]
Run solver and view results [# Plot functions ]
Use random states from previous run £ | | Output function )
Display to command window ]
Pz 'S S
b User function evaluation ]
eration: Clear Results 'l
av
Final point:
L+ i

5% 9.10 uaaumunMNsE M TUsUNTUNTA UK
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. 10‘0 Best: 15043372462.3951 Mean: 15043806743.6313
10
®  Best fitness
[}
=
<
>
2 5
2 o
N
|
0 | [ [ [ [ | | | | [
0 0.5 1 1.5 2 2.5 3 3.5 4 4.5 5
Generation 4
.. x 10
Current Best Individual
1 T T T
=
S
=
3
R=|
% 0.5 :
e
3
Q
0
1 2 3 4 5 6
Stop. | Number of variables (6)

=h.

1

.11 uaaguaumnaIn wals Iaelszana

ean
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!

— Data Experiment T1

800 .
— Data Experiment T2

— Data Experiment T3

------ Estimation Response T1 /
ey

600 ........ Estimation Response T2 /7
------ Estimation Response T3 / W,»-'/M

/ -

//

o S
//

Temperature (Degree C)
A

0 500 1000 1500 2000 2500 3000
Time (min)

{ ' v o s
319 v.12 wamauwum MR LA INMs Usznamd wlsifieun vd oy aeAye

0111 msuaasa)szanus s Tag'lif File => Export to Workspace 921/571ngii1a 19

weraen 931 0.13 uaz v.14

4\ Optimization Tool —
Help
Reset Optimization Tool
Cledg Problem Fields [
u Export To Workspace = =
ImporxOptions...
] I E timprobl
lmport PYxoblem... Export problem and options to a MATLAB structure named: | optimproblem
[7] Include information needed to resume this run
Preferences..)
[T] Export options to a MATLAB structure named: options
Export to Workspace... 7 L Export results to a MATLAB structure named: optimresutts
Generate M-File...
Close Ctrl+W

d . .
71N .13 uaaumunMMsHaaIn sz Inud s
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[T Variable Editor- optimresuitsac. s workspace hall= NI
8% 2| S| 52 | 1| stack| Base [0 selectdat... v [0 v|a x| @ o & & B | stack:| Base [ selectdatatoplot  ~ |
FH optimresults.x <156 double> Name Value Min  Max
1 | 2 3 | 4 5 6 | f 1.5043e+10 15043... 1.5043.. =~
1 0.0141; 0.5059 0'1076; 0.8207| 0.6211 0.1691. - %‘head <3301x1 double> 70.8333 862.50... I
; > ]‘tg Bﬂ:npm_mpz iss(;%m double> ;300 is)oo
4 \ ‘ optimresults <1 struct>
: B s gl
3 \ " | EH sum_error2 3.5458¢+06 35458... 35458..
8 — n  error3 1.3179e+06 1.3179... 13179...
9 f o <3301x1 double> 249200 805.87...
- - dszinmdouals v Swsiewe o oo
optimresults [ opbrmresoien %] ml <3301 double> % 83528.. _|
4 . o
JUN 214 uaaumua Al szInud s
. . o
A13199 2.1 uaaanaulsnld :nmsdszuna
auals R RIIER BN Aalszanaauls
a 0.0140906 0.0140906351
b 0.5059324 0.5059324812
c 0.1076071 0.1076071755
d 0.8207096 0.8207096080
e 0.6211386 0.6211386174
f 0.1690896 0.1690896035
2.2  ayl

1w Ay Y A Yy A [ 1w a 4 Y A
ﬂW]’JLL“]Jﬁ‘V]]’lﬂmﬂﬂﬁﬂizu1mmﬂﬂamﬁlﬂﬂuﬂUfﬂ@’JLLTJii]‘N‘UENi%UUGD'Qi]z%ﬂWEN

< 1w @ Il a a
Joyavesmsnaasinawsolsznmaidinlsla 1indredrmsnageulszaninimves

a [ a T v o o v
Juuansanes nulunisdszanamanlslunissiassdoiunsaivednsz uIUNTUIAL

pupaude Feezriuer llszgadldlumalsznaaidnlsvewuus aemundiamens

' <3 a . 9 A o 2 Y Y
YoINTZUIUMIQUIA A0 UManyia Walking Hearth 1oz 15 o0onun1isidla - Jaaumla

g1 aune 11
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A d' Yo a A d 1 =
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Srisertpol, J., Tantrairatn, S., Trakunvongngam, P., and Khomphis, V. (2011) Estimation
of the Mathermatical Model of the Reheating Furnace Walking Hearth Type in Heating
Curve Up Process. International Journal of Mathermatical Model and Method in Applied
Sciences. Issue 1. Vol5. pp.167 - 174

Srisertpol, J., Tantrairatn, S., Trakunvongngam, P., and Khomphis, V. (2011) Temerature
Control for Reheating Furnace Walking Hearth Type in Heating Curve Up Process. The 9"
WSEAS International Conference on System Science and Simulation in Engineering
(IGOSSSE’10). Iwate. Japan. 4 - 6 October. pp.464 - 469
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Abstract

The slab reheating process for iron to small diameter size 5.5 - 32 mm wire is used reheating
furnace type walking hearth to control temperature in range 1150-1200 Celsius during 2 hours by using
open-loop control. The proper temperature get by controlling fuel and number of opening burners. The
current problem is over heat inside the wall, which cause the furnace damage and the fuel loss. That
increase the primary cost of production. Moreover, the reheating furnace has been used for a long time.
So the physical characteristics might be changed, which influence to the controller. In this study will
analysis and develop the mathematical model of the reheating furnace for design. The proper controller in
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the fuel economy and good temperature response. The open-loop identification method has been applied

to the reheating furnace walking hearth type, by Nonlinear least square and Pattern search.
Keywords: Mathematical model of reheating furnace, Thermal system, System identification and

Parameters estimation
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Temperature Control for Reheating Furnace Walking Hearth Type
in Heating Curve Up Process
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Abstract: - The slab reheating process for iron rolling to the small diameter wire in Ratchasima Steel Products
Co..Ltd. factory (Nakron Ratchasima. Thailand) use the reheating furnace walking hearth type which control
the temperature of the process about 1150-1200 Celsius (up to each zone) and consume time about 2 hours.
The air fuel ratio control of this furnace is feedback control which use PID controller. The problems in the
present are reducing production cost and increasing performance in energy consumption which most cost of the
factory from in the slab reheating process. So the factory has the idea to change the energy source to the
cheaper source such as nature gas, bio-gas etc and improve the performance of the temperature control of the
reheating fumace in heating curve up process. Consequently the controller isn’t suitable for the slab reheating
process in the present then can’t control the desired temperature and lose the energy. From the mentioned
reason, we have to analysis and study to estimate the mathematical model of reheating furnace for design the
controller. This paper present the mathematical model of reheating furnace walking beam type using system
identification method to estimate the parameter of the mathematical model with the temperature response of
slab reheating process and apply adaptive system to design the suitable input with the desire response of slab
reheating process by consider to select the optimal process in terms of fuel economy and temperature response.

Key-Words: - : Mathematical model of reheating furnace. Thermal system. System identification, Parameters
estimation and Adaptive system.

1 Introduction Structure of iron reheating furnace walking beam type
The slab heating process is one temperature control is divided functionally to 3 zones in the figure 1
process which is applied widely in the industry. The
popular controller which use in temperature control
process is PID controller. The manual of the furnace
[1] describe the process of the furnace that using the
thermal energy to furnace by bumer which using

1. Preheating zone has 8 bumers type NXB-300

2. Heating zone has 8 burners type NXB-300

3. Soaking zone has 10 burners type NXB-125
Temperature of each zones are different according

double cross limit method adjust the ratio of air and to function. Preheating zone serves thf: humidity away
fuel. That the heating bumers is the feedback control from the slab by heating at approximately 700-800
system. Celsius. Heating zone provide heat directly to the slab

by heating at approximately 1100-1200 Celsius and
Soaking zone maintain a constant temperature of slab
at approximately 1150-1200 Celsius before the slab
leave the reheating furnace. In the begin, heating the
fumace can’t heat quickly because the reheating
fumace wall will be damaged when overheating then
must gradually heating properly and keep the constant
temperature in a period of time to adjust the inside
fumace wall expansion before and then heating
temperature up and using the heating up curve is the
” desired reference temperature of Soaking zone in the
opening bumer in the figure 2

Staling Zote

Fig.1 Reheating fumace walking beam type
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Fig. 2 Temperature response in each zone

Actual temperatures in the range of the reheating
furnace apply the two thermocouples to measure the
average temperature in each zone. Current ratio of air
and fuel is 10:1 and the combustion temperature is
approximately 300 Celsius.

From the study of estimated mathematical model
of slab reheating furnace [2] studied the thermal
energy associated with convection, radiation and the
various heat losses from the furnace to occur in the
slab heating process. The research [3] has proposed the
closed-loop identification of temperature response to
iron rod using data from the experiment of one iron
rod as a reference and using the quadratic error
function to find the parameter coeflicient of the
mathematical model of the iron heat treatment process.
MIMO system identification of the iron reheating
furnace using the black box model and ARX model to
nonlinear system identification by input is the fuel and
the measured output is the temperature value in each
interval [4.5]. Study the dynamic model using genetic
algorithm in frequency domain [6]. Analysis and
design controller of the electromagnetic oven process
or the slab reheating furnace by approximation of the
mathematical model with adaptive system [7.8]. This
paper has proposed open-loop identification and
thermal principles to estimate the mathematical model
of the slab reheating furnace walking beam type using
parameter estimation and design the suitable input
(open/close burner) with the desire temperature
response in heating up curve process. The
mathematical model is the stat-space model equation
and the parameter estimation method was applied
nonlinear least squares and pattern search to estimate
the parameter of the mathematical model. For
consideration in the controller design is optimal in
term of energy economy and reducing the productive
cost in the next time.
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2 The Mathematical Model of the Slab

Reheating Furnace Process

The system analysis is necessary to estimate the
mathematical model of system. We can find from the
model that was studied by taking the models are
analysis and compared with the experimental results or
using the heat transfer principles to find the structure
of the mathematical model of system. For this iron
reheating furnace walking beam type at Ratchasima
Steel Products Co..Ltd. Factory as shown in Fig. 1.
Each zone has two thermocouples to measure the
average temperature. In this case we consider all
system is the steady state flow process.

Zone Zonel

Zone3

Fig.3 The simple model of reheating furnace
walking beam type

The structure of a mathematical model under the data
which can be measured in the reheating furnace
process, applies with the open-loop identification in
parameter estimation of the simple model as shown in
Fig. 3. That can be design the control method to
control temperature inside the slab reheating furnace in
the performance of work under current conditions.

Zone 1 —Soaking zone

Fig.4 The thermal system at zone 1

From the thermal system consider the heat transfer
between the different temperatures as show in Fig. 4
by analysis in term of thermal capacitance as the
equation

L dT
G4 =0"% (M

The thermal resistance of heat flow rate from zone 1 to
zone 2 can be written

ISBN: 978-960-474-230-1
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where C, —thermal capacitance at zone 1
R, — thermal resistance at zone 1
¢, — heat flow rate to zone 1
¢, — heat flow rate from zone 1 to

zone 2
T, — temperature at zone 1

T, —temperature at zone 2

Zone 2 — Heating zone

P

g T

PR op

S

Fig.5 The thermal system at zone 2

The thermal capacitance of zone 2 as shown in fig.5
can be written to

i
C,—==¢q,—q (3)
2" 1> — 43

The thermal resistance of heat flow rate from zone 2 to
zone 3 can be written:

L,-T,
g, =—2—2 “4)
R,
where C, — thermal capacitance at zone 2
R, — thermal resistance at zone 2
¢, — heat flow rate from zone 2 to
zone 3
T, - temperature at zone 3
Zone 3 - Preheating zone
s
e
Tt 7, 7,
. G
Qs IRS
Fig.6 The thermal system at zone 3
ISSN: 1792-507X

The thermal capacitance of zone 3 as shown in Fig. 6.
we can write the relative equation to:

iT.
C=t=g,—q, (5)
dt

The thermal resistance of heat flow rate from zone 3
to environment can be written

(6),

where (; — thermal capacitance at zone 3
R, — thermal resistance at zone 3
q, — heat flow rate from zone 3 to

environment
— ambient temperature

T,

air

We can rearrange the equation 4, 5 and 6 to

= h =T+, U

1

RC,

*“RC, 1
1

L

RC,
7, =-L-T —[-l—+

RC,

G
I

—_— T +—
R:C:] TORG

7, (8)

9)

7t =|_ﬁ = _+; /i +;T_
RZC.‘ i R2(7.\ R.‘C.\ R3C3

So we can arrange to state-space equation form

L
RC,
1

RC,
0

o B T B
I

|

G

+ 0 |q,+
0

From the equation 10 can rearrange the new equation

to

-a

EENCTNE
I

0

1

where ;= ,p=

RI CI
|
RC,

&=

0
0
1

T

ar

RC,

a

b —(b+c)

d

('l

o 51 [r] [o
~(d+e)|[T ]| |0 e

| 1 1
RC,

and f=L

ISBN: 978-960-474-230-1

P I |

¢ || |+|0g+ 0], (11

(10)




147

SELECTED TOPICS in SYSTEM SCIENCE and SIMULATION in ENGINEERING

3 Problem Solutions
3.1 Open-loop Identification

The slab reheating furnace process is the open-loop
control process. The mathematical model of slab
reheating furnace process with experiment results can
be estimated the parameter via nonlinear least squares
and pattern search which increase the temperature of
the reheating furnace according to the step open of
burner. That is divided to 4 ranges. In the first range
the fumace open two bumers at zone 1 about 510
minutes, the second range the fumace open four
burners until 2670 minutes, the third range the fumace
open six bumers until 3170 minutes and the forth
range the furnace open ten bumers until 3310 minutes.
The system which control air to fuel ratio of 10:1 is
the closed-loop system using PID controller. In the
condition at flow rate is 40,000 m*h, pressure is 5
bars, the air temperature is 350 Celsius and the fuel is
110 Celsius.

The method of open-loop identification via
parameter estimation technique can be estimated the
mathematical model of slab reheating furnace with
measuring temperature in heating curve up process.
The investigation of the coefficients in the
mathematical model (11) is a complex problem
because of restricted information input temperature
can be measured. The logical criterion might be to
minimize the sum of residual errors (¢) for all the
available data. as in

N

e=Y[1.6)-7,()] (13)

1=l

where N -total number of data. ﬁ(;) is the

temperature measurement from the mathematical
model of slab reheating furnace in heating curve up
process

3.2 Experimental and Simulation Results

In the experiment to estimate the parameter with
Non-linear least squares and Pattern search of the slab
reheating fumace process at Ratchasima Steel
Products Co..Ltd. Factory use the increased furnace’s
temperature process according to the heating curve up.

The  response of  temperature from
experimentation and simulation as shown in figure 7,
8 and 9 take to estimate the parameter with nonlinear
least squares and Pattern search method as shown in
Table 1. The average error for all 3 zones using the
parameter estimation compare with —measured
temperature with non-linear least squares method is
7.3953 and Pattern search method is 15.1496.
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Fig. 7 Temperature responses of the experiment and
the estimate model at zone 1
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Fig. 8 Temperature responses of the experiment and
the estimate model at zone 2
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Fig. 9 Temperature responses of the experiment and
the estimate model at zone 3
Tablel. Parameter estimation of the mathematical

model
Parameters Para estimation
Pattern Nonlinear least
search squares
a 0.12028 0.00888
b 0.92183 2.9412
c 0.017474 0.78088
d 3.1801 096634
e 2.7854 0.72051
F i 0.15592 0.14266
Error” 15.1496 739533
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3.3 Design Procedure of the Open Burner via
Adaptive System and Constraint Function

The design procedure of the open 10 burners in heated
furnace process must consider the response of
temperature in soaking zone (7)) according to heating
curve up and saving energy. When we have the
estimated mathematical model of slab reheating
furnace process and variable via parameter
identification method, we can apply the adaptive
system and constraint function to find out the number
of burners that are opened (k) and the corresponding

time (I) The gradient method is to adjust parameter

in such a way that the loss function is minimized

J(k) =%e2 (14)

where e=T,, —1.T,, — temperature of heating curve
up at soaking zone.
The objective of an adaptive system is adjust the
number of burners until the error between the
temperature  of heating curve up (7, )and the
temperature (7)) of the estimated mathematical model
of slab reheating furnace process is close to zero. Thus
we assign the parameter of the number of bumers in
the negative gradient of J

Ok _ _yedJ _ yede

(15)
ot ok ok
and
g = _% (16)
ok ok

where y is adaptation gain. The sensitivity function is

Ou 0q,
—=—au+tav+k—=1+ 17
. au+ay B q (17)
where u=£. v=aiand w=ai
ok ok ok
ﬂ=hu—h\'—c\'+c\r (18)
ot
ow
i=d\f‘—a'w—ew (19)
ot

The constraint functions are
k is integer number and 2<k <10
t isreal number and >0
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Fig. 11 The response of temperature to the opening of
the new bumers in soaking zone.

The result of the program to find the number of
burners (k) and corresponding time (t) as shown in the
fig.10 and the response of temperature to the opening
of burners as shown in the fig.11. We can reduce the
error (ems) of temperature down to 26.21 % and saving
energy to 2.26%.

4 Conclusion

This paper has proposed the estimated method to
estimate the mathematical model using the open-loop
identification for the slab reheating furnace walking
beam type with non-linear least squares and pattemn
search method in heating curve up process. The
results from simulate and measured temperature
response have relative response so the mathematical
model can take to design open-close burner to control
the suitable temperature with heating curve up and
save the energy of the slab reheating fumace.
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